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01. Manajemen penerbitan artikel

OJS 3 mulai dari peran yg ada di OJS, workflow di OJS,
serta poin-poin penting yg harus diperhatikan pada saat
submisission hingga publish

02. Layout artikel jurnal

usulan contoh layout artikel yg baik untuk template,
item-item yg harus ada pada artikel, hingga checklist
terkait ilustrasi (table & figure)

03. Penggunaan bahasa

poin-poin penting sesuai Scopus Policy and Selection yg
harus diperhatikan, terutama terkait clarity of abstract
dan readability of articles

MANAJEMEN PENERBITAN OJS 3

Apa topik
diskusi kita
hari ini?



Survel 3 menit
dik.si/unp-ojs
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Role di O]S

_ _ Manajemen penerbitan
Manajemen jurnal

Manajemen situs terdiri dar:
Journal manager 1.Editor
IT support/web admin e setup 5 tahap jurnal 2.Section Editor
* instalasi OJS pada server e siapkan konten akreditasi 3.Reviewer
* back-up sistem dan data e siapkan untuk indeksasi 4.Copy Editor
* update ke OJS terbaru e setup Creative Commons 5.Layout Editor
* pengamanan dari hacker e setup Statistic Counter 6.Proofreader

* restore/memperbaiki sistem e buat profil GS jurnal 7.dlIsb.




MENURUT ANDA, MANA RUTE YANG IDEAL?

&
7

Author > Editor > Reviewer Author > Reviewer > Editor
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OJS Workflow

Submission

Di sinilah artikel baru diterima oleh Editor dan ditugaskan ke
Section Editor yg kemudian dipertimbangkan ke tahap Review.

Review

Tahapan saat peninjauan sejawat terjadi serta segala revisi (dari
komentar Reviewer) yang perlu ditindaklanjuti oleh penulis.

Copyediting

Artikel yang diterima akan dipindah ke tahap ini. Berikutnya, artikel
akan disunting oleh Copy Editor.

Production

Setelah copyedit selesai dan disetujui oleh semua pihak, lalu artikel
dijadwalkan untuk terbit di edisi mendatang.
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Christy Summers
Editor

Tim Editorial Jurnal Sultan

Trevor Hines

Section Editor

Juan Mendez
Copy Editor

Christy Summers
Layout Editor

Colleen Perez

Proofreader
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David Barnes
Editor

Tim Editorial Jurnal Rintisan &

David Barnes

Section Editor

David Barnes
Copy Editor

David Barnes
Layout Editor

David Barnes

Proofreader



Bgmn alur
penerbitan

dari submit hingga terbit?



diadaptasi dari PKP School: pkpschool.sfu.ca/course

Step by step alur penerbitan artikel

01 Submitting an Article

(02 Responding to a Submission

03 Assigning a Reviewer SE
04 The Reviewer's Steps Reviewer
05 Responding to the Reviews Author
06 Copyediting SE
O7/ Production SE

08 Issue Management

Author

Siapa yg
terlibat?

SE

Reviewer

Keterangan

SE = Section Editor
CE = Copy Editor
LE = Layout Editor
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01. Submitting an article

Apa yg harus
dilakukan ED?

¢ cek kelangkapan file artikel dan komponennya
(dataset, instrument, material, dlsb)

¢ cek kelengkapan & kebenaran metadata (title,
abstract, keywords, contributors, reference)

Suplemen:
e https://youtu.be/5ZUIgCSOVEC

e erickunto.com/2021/02/5-tahap-mengirimkan-artikel-via-ojs.html

AUTHOR (AU) & EDITOR (ED)

Submit an Article

1, Start 2. Upload Submission 3. Enter Metadata 4. Confirmation 5. Next Steps

Files Add File

Upload any files the editorial team will need to evaluate your submission. Upload File

Save and continue Cancel

Submit an Article

1. Start 2. Upload Submission 3. Enter Metadata 4. Confirmation 5. Next Steps

Prefix Title *
The

@ I Officl g and Adult Education Agents Q
Examples: A, The

Frangais (Canada)

l This field is required.
pedl Development-Oriented Nongovernmental Organization in the North of Pagiug

Subtitle
An Ethnographic Study of the Adult EQ

Abstract *
h i B 7 Y 2 xX x £ &2 < i & Q

-~

Nongovernmental erganizations, particularly those related to development work (local development-oriented nongovernmental
organizations; LDNGO), and their agents have been assuming, in Portugal, an important role in the field of adult education. These
organizations develop with the State, at the national level, and with supranational institutions and programs different types of
relationships and arrangements, as a result of the activity in such educational arena. This article intends to question, on the basis

of an ethnographic study of an adult education team of an LDNGO and using the pedagogical discourse model of Bernstein, the
relationship that these agents establish with the official knowledge (pedagogical discourse) emerging from State-dependent
intervention bodies. The results of the study shows that, even in strongly prescriptive working contexts, it is possible to develop o~

Kredit Gambar: https://docs.pkp.sfu.ca < >


https://youtu.be/5ZUlgCS0vEc
https://docs.pkp.sfu.ca/learning-ojs/en/authoring

EDITOR (ED) & SECTION EDITOR (SE)

My Queue Unassigned All Active Archives &
O Help

02_ Responding to Archived Submissions Q  Search P ————

T Filters " Pink -(o Subrission j.

| u
a Submission P okt )
Overdus A No editor has been assigned to this submission.
Incomplete -~ ~
” Ungbha Korn { © submission )
Inactive for 30 days #1TheyGunnedMeDown: How Ethics, Gender, and Race Intersect When ] ”
Researching Race and Racism on Tumblr
Stages A Noeditor has been assigned to this submission.
Submission
Review 75 Couldry :U SUhmlssmn-\}
What's at Stake in Digital Social Research? ’ b
Copyeditin
Py 9 £ Mo editer has been assigned 1o this submission,
Production
7 Abidin (‘0 submission )
o S —
SAcrSm Tacit Labouwrs of Digital Social Research as an Early Career Researcher v
p q y g q r u ! Articles & Mo editor has been assigned to this submission,
Journal of Public Knowledge - Tasks [ @ English ® View Site & dbarnes

Metadata Editorial History Submission Library

dilakukan ED? 0JS

Submissions

The Official Knowledge and Adult Education Agents
Joe Willlamson, Frederic Serletis

Submission Review Copyediting Production © Help
Issues

. . ] ol Submission Files Q Search Upload File mu i
cek kesesuaian artikel dengan aim and scope Users & Roles

2 471 jwilliamson, Author, submission.docx Article Text Accept and Skip Review

jurnal; cek indikasi pelanggaran etika publikasi e vomntosaanries [

Participants Assign

delegasikan artikel ke Section Editor melalui

Pre-Review Discussions Add discussion Journal editer
Assign pada blok Participants P
v [publicknowledge] Editorial Assignment dbarnes - ] Section editor
Qctf26

»  David Buskins

*  Stephanie Berardo

Suplemen: https://youtu.be/CIZmk65QQHM Kredit Gambar: https://docs.pkp.sfu.ca < >
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03. Assigning
a Reviewer

Apa yg harus
dilakukan SE?

¢ jika double-blind review, hapus identitas author
di artikel maupun metadata dokumen

¢ tugaskan Reviewer via Send to Review > Select
Reviewer. Ulangi jika reviewer lebih dari 1 orang

Suplemen: https://youtu.be/iW-ji_ylCKI

SECTION EDITOR (SE) & REVIEWER (RE)

Journal of Public Knowledge - Tasks o

Q)

Joe Willlamson, Frederic Serletis

@ English ® View Site & minoue

Metadata Editorial History Submission Library

The Official Knowledge and Adult Education Agents

Submissions
Submission Review Copyediting Production 0 Help
Round 1 MNew Review Round
Round 1 Status
Waiting for reviewers to be assigned.
Review Files Q Search Upload/Select Files Make Recommendation
48-1  Author, submission.docx
Participants Assign
Journal editor
Reviewers Add Reviewer * Daniel Barnes
Section editor
Reviewers Add Reviewer
» Julie Janssen Request Sent Double-blind
Response due: 2019-06
v Paul Hudson Request Accepted Double-blind
Review due: 2019-06-14
Review Details Email Reviewer Edit Cancel Reviewer History
Login As Editorial Notes

Kredit Gambar: https://docs.pkp.sfu.ca
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REVIEWER (RE)

Review: approach for externalization of expert tacit knowledge

1. Request 2. Guidelines 3. Download & Review 4. Completion

04. Reviewer's Steps RO

You have been selected as a potential reviewer of the following submission. Below is an overview of the submission, as well as the timeline for this review.
We hope that you are able to participate.

Article Title
approach for externalization of expert tacit knowledge

Abstract

E-learning or electronic learning platforms facilitate delivery of the knowledge spectrum to the learning community through information and
communication technologies. The transfer of knowledge takes place from experts to learners, and externalization of the knowledge transfer is significant. In
the e-learning environment, the learners seek subject expertise to clarify their subject queries, and a learner query can be routed to an expert for

externalization of expert knowledge provided the learner knows the subject expert or the expertise group. However, learners new to e-learning systems are
not aware of the expertise group to which the query should be sent, which results in time delays, non-response, inaccurate solutions and loss of knowledge
capture. Several models have been proposed to resolve this task, but thus far, these efforts have focused completely on returning the most conversant
people as experts on a particular topic to retrieve valuable knowledge. To address this problem, we propose an approach that externalizes the tacit

knowledge of a subject expert by creating a dynamic query handling system that automatically transfers a user query to the best subject expert.
terima undangan review via Review > Accept

Upload
Upload files you would like the editor and/or author to consult, including revised versions of the original review file(s).
Reviewer Files Q, Search Upload File
No Files

Review lalu unduh artikel

Recommendation

be rl kCI n feed ba C k S u bStC] n S | G I VI G M s 0 WO rd > Select a recommendation and submit the review to complete the process. You must enter a review or upload a file before selecting a recommendation.

Choose One i

Review dan rekomendasi yg jelas kepada Editor
Suplemen:
e https://youtu.be/NgVxnLror8s

e erickunto.com/2021/02/menghilangkan-nama-pemberi-
komentar-di-word.html Kredit Gambar: https://docs.pkp.sfu.ca < >

* Denates required field
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Rekomendasi
Reviewer

Beri rekomendasi
yang jelas!

Accept Submission
jika artikel siap langsung ke proses Copyediting

Revisions Required

ada minor revision yg harus ditinjau dan diterima oleh Editor

Resubmit for Review

ada major revision dan harus dicek pada Round berikutnya

Resubmit Elsewhere

artikel tidak cocok untuk fokus dan ruang lingkup jurnal

Decline Submission

artikel terlalu banyak kekurangan yg harus dibenahi

See Comments

meminta Editor untuk memutuskan berdasarkan catatan



AUTHOR (AU)

0J53.203 Tasks () @ English = ViewsSite & [jacobs
Submissions
05.R di
5. Responding to el . e
O Help
u . "
the Reviews
My Assigned Q  Search New Submission
6 Jacobs O Review
What are innovations in peer review and editorial assessment for? ~
31
£\ Revisions have been requested Al
3 pmangahis O Review
Anti- Classism and Socio-Economic Equity Directive w

33 1

A Revisions have been requested.

Apa yg harus
dilakukan AU?

1. Upload File 2. Review Details 3. Confirm

If you are uploading a revision of an existing file, please indicate which file.

¢ unduh artikel dan balas komentar Reviewer via Author, submission-manuscript.docx
Ms. Word > Review. Aktifkan Track Changes

4k

Article Component *

¢ unggah artikel yg telah direvisi sesuai komentar Article Text
Reviewer via Upload File

L 1L

Drag and drop a file here to begin upload Upload File

Suplemen: https://youtu.be/X_E7A3q7mQU Kredit Gambar: https://docs.pkp.sfu.ca < >
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06. Copyediting

Apa yg harus
dilakukan SE & CE?

¢ unduh artikel via Revisions dan cek apakah
Author telah melakukan revisi sesuai komentar

¢ delegasikan artikel kpd Copy Editor yg kompeten
dan ahli bahasa via Assign pd blok Participants

¢ Copy Editor melakukan suntingan dan unggah
hasil copyedit lalu centang artikel terkait

Suplemen: https://youtu.be/Yx3tlufAenU

SECTION EDITOR (SE) & COPYEDITOR (CE)

PKP OJS 3.3 Test Journal 8

PRIk 31 | TestAuthor | A Sample Submission for Review Testing: subditle Preview  Activity Log  Library

Issues

Workflow Publication

Assign a copyeditor using the Assign link in the Participants list,

Website
Workflow | Notification

Draft Files Q Search Upload/Select Files Send To Production

Statistics
Articles eI Participants Assign
Editorial Activity
1 edi
Copyediting Discussions Add discussion Journal editor
Users
b editor
Reporis
»  [pkpy] Copyediting Request editor . [i] Copyuditor
Togks 0219f2021 » copyed
S:42am
Copyedited @ Search Upload/Select Files

P
Add Participant o nels b4

Locate a User

Copyeditor :
Search User By Name
Search
Name
Maria Fritz
[« ] Sarah Vogt

2 of 2 items

Kredit Gambar: https://docs.pkp.sfu.ca < >
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EDITING VS. PROOFREADING

Editing Proofreading
v/ Grammatical error check v/ Spell check
v Style consistency check v/ Punctuation check
N4 Proper word choice check v/ Consistent capitalization check
v/ Sentence structure and flow check v/ Consistent abbreviation & acronym usage

Sumber: O'Rourke, Tony. (2021). How to Avoid Rejections Due to Language Mistakes -




SECTION EDITOR (SE) & LAYOUT EDITOR (LE)

o @
. - il = = 3 tAuthor Sample Submission fior Review Testin g: subtitle e ] ry
i . y
_— — [ § = ] —
———— 1 o ro u C I 0 n Workflow Publication
- [ ]
— i ety ﬁ'.'--. —
bmission  Revie W Copyediting = Prodactln = ane
Notification
aiting Copyed

Draft Files Q Search Upload/Select Files Send To Production

Participants Assign

Copyediting Discussions Order Add discussion

Apa yg harus — LT T =
dilakukan ED & LE?

¢ Editor memproses artikel ke tahap Production Locate a User
via Send to Production Layout Editor v =
¢ delegasikan artikel kpd Layout Editor via Assign —
pada blok Participants lalu pilih Layout Editor
¢ Layout Editor me-layout dan unggah artikel via ’ By Ecox
Add Galley > Upload File > Article Component 10f 1items

Suplemen: https://youtu.be/4jwpwV3boKk Kredit Gambar: https://docs.pkp.sfu.ca < >
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08. Issue
Management

Apa yg harus
dilakukan ED?

¢ klik Issues > Future Issues dan klik Create Issue.

Isi data pada form isian. Tambahkan sampul

¢ pilih artikel yg siap terbit via Submission >
Production lalu Schedule for Publication

¢ buka Table of Content dan urutkan artikel.
Lengkapi form isian. Terakhir klik Publish Issue

Suplemen: https://youtu.be/FbQDrhMNw3M

EDITOR (ED)

Issues

Future Issues Back Issues O Help

Future Issues Create Issue

» Vol 1 No 3 (2018) 0

Identification

1 3 2017
Volume Number Year
Title
Volume Number Year || Title
Table of Contents Issue Data Issue Galleys Identifiers
Order
Articles

» Resource reguirements and costs of developing and delivering MOQOCs
»  Assumptions and challenges of open scholarship

*  Guidelines for Transferring Residential Courses into Web

Kredit Gambar: https://docs.pkp.sfu.ca < >
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Pekerjaan
Editor 1tu berat,

namun bisa diperingan dgn
membuat artikel template
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4.Penulis, ORCID, afiliasi, email

5.CrossMark @M

6.Abstrak

7.Logo Open Access @M

8.How to cite

9.Editor <&M
10.Article history
11.Copyright, license, permission
12.Data availability statement (termasuk <N
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13.Funding statement QN
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3 RESEARCH ARTICLE

The skipping behavior of users of music

3 streaming services and its relation to musical

structure

9 Nicola Montecchio'*, Pierre Roy?, Frangois Pachet®

1 Spolity, Berlin, Germany, 2 Spolily, Paris, France
* venice @spotify.com

Abstract

The behavior of users of music streaming services is investigated from the point of view of
the temporal dimension of individual songs. Specifically, the main object of the analysis is
the peint in time within a song at which users stop listening and start streaming another song
(“skip®). The main contribution of this study is the ascertainment of a correlation between the
distribution in time of skipping events and the musical structure of songs. It is also shown
that such distribution is not only specific to the individual songs, but also independent of the
cohort of users and date of observation. Finally, user behavioral data is used to train a pre-
dictor of the musical structure of a song solely from its acoustic content; it is shown that the
use of such data, available in large quantities to music streaming services, yields significant
improvements in accuracy over the customary fashion of training this class of algorithms, in
which only smaller amounts of hand-labeled data are available,

Introduction
Since the advent of online music streaming services, people have been able to easily access mil-
lions of songs on demand. As a conseq) e of this abund , novel listening behaviors have

emerged: departing from the passive, concentrated listening practice that is typical of media
such as LPs, today people tend to listen to music in a much more frantic way than before.

The central object of interest of this paper is the behavior of users regarding “skipping™: the
act of interrupting a song in order to listen to the next song in the music queue (the queue pos-
sibly being the rest of the song’s album, a playlist in which the song figures, or a sequence of
songs proposed by the recommendation engine of the streaming service).

It is our opinion that skipping is a crucial feature in understanding modern listening behav-
iors, For the first time in the history of musicology, researchers can systematically collect and
analyze massive amounts of data about music listening behavior. Streaming services are only
one of many possible contexts in which music is consumed; as such, one must be aware that
any observed behaviour is not necessarily generalizable to other situations (e.g., it is safe to
assume that skipping behaviour in the context of listening to LPs is radically different from the
online music streaming case described in this paper); nonetheless, online streaming services

PLOS ONE | hitps://doi.ong/10.1371/joumal pone.0239418 - September 30, 2020 1116
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PLOS ONE The skipping behavior of users of musi g servi dits relation to musical structure €€

18. Title header
19. Ucapan Terima Kasih ‘ -
20. Kontribusi penulis sesuai CRediT Q&1 Lavestigatio: Nica Montcei, e Ry, Fragols Pache,

insights during the initial phases of this work.

® Author Contributions
Conceptualization: Nicola Montecchio.

The authors would like to acknowledge the contribution of Fernando Diaz for the valuable

Methodology: Nicola Montecchio.
21. Daftar Pustaka S T S
Writing - original draft: Nicola Montecchio, Frangois Pachet.
Writing - review & editing: Nicola Montecchio.
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yg akan dibuat?



https://www.overleaf.com/gallery/tagged/academic-journal/page/12

Kabir, SMS (2016). Basic Guidelines for Research: An Introductory Approach for All Disciplines.

Table

adalah nilai numerik atau teks yg ditampilkan
dalam baris dan kolom. Tujuan utamanya untuk
meringkas informasi numerik dlm jumlah yang
besar dan menyajikannya mjd informasi yang
sesederhana mungkin sesuai tujuan penelitian.

Percantik layout

dgn ilustrasi + meningkatkan pemahaman pembaca

Figure

adalah semua jenis ilustrasi (chart, graph, map,
photograph, drawing, dlsb.) selain tabel. Setiap
figure memiliki fungsi masing-masing:

e diagram pie > persentase;

e diagram garis > tren dari waktu ke waktu.



FIGURE CHECKLIST

1.Apakah figure memang diperlukan?

2.Apakah figure sederhana, jelas, dan bebas
dari objek yg tidak diperlukan?

3.Apakah data diplot secara akurat?

4.Apakah skala sdh tepat dan proporsional?

5.Apakah tulisan cukup besar untuk dibaca?
Apakah ukuran huruf sudah sesuai dgn
figure lainnya?

6.Apakah angka-angka pada figure paralel
dan disusun menurut skala yg sama?

/.Apakah istilah yg digunakan telah ditulis
dgn tepat?

8.Apakah semua singkatan dan simbol
dijelaskan dlm legenda atau keterangan
gambar? Apakah simbol, singkatan, istilah
ditulis secara konsisten?

9.Apakah figure telah dinomori secara urut
dengan angka Arab?

10. Apakah semua figure telah disebutkan dim

teks?




Tahukah kamu?

Image
manipulation

pelanggaran etika yg sering diabaikan
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WHAT IS IMAGE MANIPULATION?

Pl H5 0

|

L |
Cropping that Brightness/ Selective Colour Cloning an
changes the contrast enhancement of adjustment object into an
context of the adjustment that  the image with the that distorts the image in
final image fades or vanishes intent to support observation and which it did

part(s) of the the proposed the conclusion not appear
image hypothesis from the image previously

i'

WHAT ARE THE IMPLICATIONS?

s O

Affects research Impacts May result in paper -{, 'S
integrity. Considered  reproducibility of retraction, damaged a\"‘ N>
a misconduct the outcome reputation and career, ete. AW

9.:€11ago academy

Learn. Share. Discuss. Publish.
Saurce: hitpa/ feri. hbagorfeducotion/preducts [Mandimages,practices dofoult himl



TABLE CHECKLIST

1.Apakah tabel memang diperlukan?

2.Apakah semua tabel yang sebanding
disajikan secara konsisten?

3.Apakah judulnya singkat dan jelas?

4.Apakah setiap kolom memiliki judul?

b.Apakah semua singkatan; penggunaan
khusus huruf miring, tanda kurung, dan
tanda hubung; dan simbol khusus telah
dijelaskan?

6. Apakah semua nilai tingkat probabilitas
diidentifikasi dengan benar, dan tanda
bintang dilampirkan ke entri tabel yang
sesuai?

/.Apakah catatan disusun menurut konvensi
umum, khusus, dan probabilitas?

8.Apakah semua garis vertikal telah dihapus? &

9.Apakah tabel dan data dari sumber lain <l !
telah dirujuk dengan tepat? 40 |

10. Apakah semua tabel telah disebutkan dim s
teks? 2 35 SUN |

Kredit: luxizeng 45
2. 84 e |

o~
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Makin tinggi
keterbacaan

semakin tinggi pula jumlah
pembaca. Ingat, readability
tidak hanya terkait tipografi.



SCOPUS CONTENT POLICY AND SELECTION

Category

Criteria

Journal Policy

Convincing editorial policy

Type of peer review

Diversity in geographical distribution of editors
Diversity in geographical distribution of authors

Content

Academic contribution to the field

Clarity of abstracts

Quality of and conformity to the stated aims and scope of the journal
Readability of articles

Journal Standing

Citedness of journal articles in Scopus
Editor standing

Publishing Regularity

No delays or interruptions in the publication schedule

Online Availability

Full journal content available online
English language journal home page available
Quality of journal home page

Sumber: scopus.com

Apa saja kriteria
ttg kebahasaan
dl SCopus’

v Clarity of abstract
v Readability of articles

Ini hanya kriteria
minimal, Ferguso!



https://www.elsevier.com/solutions/scopus/how-scopus-works/content/content-policy-and-selection

Wallwork, Adrian and Anna Southern. (2020). 100 Tips to Avoid Mistakes in Academic Writing and Presenting

Clarity of Abstract

Be concise - especially in the first Don’t begin the abstract with non
sentence key words

Tulis yg benar-benar diperlukan. Abstrak yang lebih Kurangi jumlah kata-kata non-keyword (kata yang
ringkas dan padat cenderung lebih dingat pembaca. tidak memberi nilai tambah bagi pembaca).
Make it clear why the purpose of Clearly differentiate between the
the investigation is important SOTA and what Author did

Soroti poin-poin penting mengapa riset ini Tonjolkan kontribusi dari hasil riset ini pada bidang

dilakukan. Tegaskan pada 3 kalimat pertama. ilmu dan disiplin ilmu lainnya.




Wallwork, Adrian and Anna Southern. (2020). 100 Tips to Avoid
Mistakes in Academic Writing and Presenting

1.The first words of a paragraph or sentence should
immediately tell the reader what the subject is.
2.Avoid a colloquial style and idiomatic expressions.

3.Do not use synonyms to avoid repeating a keyword.

4.When highlighting important information, consider

beginning a new sentence or paragraph.
5.When highlighting important information, be as

concise and precise as possible.

Bgmn cara meningkatkan
readability artikel?

TR - Q Y ) N PR
Kredit: LinkedIn SoIe_s-:.,NngotOnzp-wggw
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